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Inside Switch Qutside Switch
.
Load Balancing: == Node1/Control === | ,2d Balancing:
PBR or ECMP : PBR or ECMP
' inside eth1/2 eth1/1 outside etho/0
eth0/0 70.1.1.1 (main) 00.165.201.1 (main) -
10.1.1.2 (local) 209.165.201.2 (local)
inside eth1/2 LYP cth1/1 outside 1/
iy 70.1.1.3 (local) $97500.165.201 3 (local) kb
Node3
sl inside eth1/2 eth1/1 outside -
10.1.1.4 (local) 209.165.201.4 (local) .
Node4
inside eth1/2 _@ | cthi/1 outside -
g 70.1.1.5 (focal) MRS 705,165 201 5 (loca) e
-1.1. G US.102.2U1 .20 {100
D )

N

xR

BT REEHIER

DI %N ES

ANSCREE 2 JRRSIX LK M8 IE -

RO R, B4 ASA #2 SR B B O 1P HuhlFl MAC Hidik. 55T 560 (19 8% i1 (PBR) /&
— AR B T
WEAR T A AR PBR JFA 8 78 00 R FUEAT (W AR B0, FRAT T U HI 7 2%

PBR AR 4 4 B SR I ACL AR H B H S o ISR RE P T H ASA Z RT3kl . HT
PBR &AM, D] BEA NGk SE s £ (1 T B30T R . O TR AR R RE, Ui &
PBR %M, DUEIERE (1) 5 Al B AR [ 2o A0 1) 2[R —A ASA. il Wiy — & JRHS th
A, AT R GURER (1 B TOS PBR BT SEIRTUAR . R 10S X & ERERE H] ICMP ping W54 &
ASA. X5, PBRUTHIEHEE ASA IRV I MK AT P A F 2% ch ks o AT OCTRAIE I, WS BT
URL:
http://www.cisco.com/c/en/us/solutions/data-center-virtualization/intelligent-traffic-director/index.html

http://www.cisco.com/en/US/products/ps6599/products_white paper09186a00800a4409.shtml

R H
{F FHA ST R N, A ASA B O H A (3B A O TP HiliE AT MAC Mk 254 £ 4% (ECMP) % /&
— PSR BRI T

R C AT ECMP I Ay 8278 70 A BT 10 6 Rt e, AT T U I vk
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! Cluster interface mode
cluster interface mode individual
|
! VXLAN peer group
object-group network cluster-peers
network-object host 10.6.6.51
network-object host 10.6.6.52
network-object host 10.6.6.53
network-object host 10.6.6.54
|
! Alternate object group representation
! object-network xyz
! range 10.6.6.51 10.6.6.54
! object-group network cluster-peers
! network-object object xyz
|
! Cluster control link physical interface (VXLAN tunnel endpoint (VTEP) src interface)
interface gigabitethernet 0/7
description CCL VTEP src ifc
nve-only cluster
nameif ccl
security-level O
ip address 10.6.6.51 255.255.255.0
no shutdown
|
! VXLAN Network Identifier (VNI) interface
interface wvnil
segment-id 1
vtep-nve 1
|
! Set the CCL MTU
mtu ccl 1654
|
! Network Virtualization Endpoint (NVE) association with VTEP src interface
nve 1
encapsulation vxlan
source-interface ccl
peer-group cluster-peers
|

! Management Interface Using DHCP

interface management 0/0

nameif management

ip address dhcp setroute

no shutdown

|

! Alternate Management Using Static IP

! ip local pool mgmt pool 10.1.1.1 10.10.10.4

! interface management 0/0

! nameif management

! ip address 10.1.1.25 255.255.255.0 cluster-pool mgmt pool
! no shutdown

|

! Cluster Config

cluster group clusterl

local-unit A

cluster-interface vnil ip 10.2.2.1 255.255.255.0
priority 1

enable noconfirm

!

| INTERFACES

!

ip local pool inside pool 10.10.10.11 10.10.10.14

ip local pool outside pool 10.11.11.11 10.11.11.14
!
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interface GigabitEthernet0/1

nameif inside

security-level 100

ip address 10.10.10.10 255.255.255.0 cluster-pool inside pool
|

interface GigabitEthernet0/0
nameif outside
security-level O

ip address 10.11.11.10 255.255.255.0 cluster-pool outside pool
|

'JUMBO FRAME RESERVATION for CCL MTU
jumbo-frame reservation

HIETH S Day0 EL B

R LU Day0 FC BRSSP RCE . RSO s 8 A I 1Y 10 Day0 BC & P 5k
fE

\ )

IR JACE S UEREA LA E . Day0 it BN AFEVF AT . SSH TR . ASDM Vi [a] 55 At 152
A% Day0 BUE MR R, SRR

I'BOOTSTRAP

! Cluster interface mode

cluster interface mode individual

|

! VXLAN peer group

object-group network cluster-peers
network-object host 10.6.6.51
network-object host 10.6.6.52
network-object host 10.6.6.53
network-object host 10.6.6.54

|

! Alternate object group representation
! object-network xyz

! range 10.6.6.51 10.6.6.54

! object-group network cluster-peers

! network-object object xyz

|

! Cluster control link physical interface (VXLAN tunnel endpoint (VTEP) src interface)
interface gigabitethernet 0/7
description CCL VTEP src ifc

nve-only cluster

nameif ccl

security-level O

ip address 10.6.6.52 255.255.255.0

no shutdown

!

! VXLAN Network Identifier (VNI) interface
interface wvnil

segment-id 1

vtep-nve 1

!

! Set the CCL MTU

mtu ccl 1654

!

! Network Virtualization Endpoint (NVE) association with VTEP src interface
nve 1

encapsulation vxlan
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source-interface ccl

peer-group cluster-peers

|

! Management Interface Using DHCP
interface management 0/0

nameif management

ip address dhcp setroute

no shutdown

|

! Alternate Management Using Static IP

! ip local pool mgmt pool 10.1.1.1 10.10.10.4

! interface management 0/0

! nameif management

! ip address 10.1.1.25 255.255.255.0 cluster-pool mgmt_ pool
! no shutdown

|

|

Cluster Config
cluster group clusterl
local-unit B
cluster-interface vnil ip 10.2.2.2 255.255.255.0
priority 2
enable noconfirm
|
! INTERFACES
|
ip local pool inside pool 10.10.10.11 10.10.10.14
ip local pool outside pool 10.11.11.11 10.11.11.14
|

interface GigabitEthernet0/1

nameif inside

security-level 100

ip address 10.10.10.10 255.255.255.0 cluster-pool inside pool
|

interface GigabitEthernet0/0

nameif outside

security-level O

ip address 10.11.11.10 255.255.255.0 cluster-pool outside pool
|

! JUMBO FRAME RESERVATION for CCL MTU

jumbo-frame reservation

MBS F ASA Virtual &£ 2%

BAEERE ASA virtual JElCE ERE, ERATLL NS .
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BT R, AR 1| SR R R AT R

T s LR EEFHEOER

FEJG HIERAE AT, 15 2R B KB HAt R AT BN 1o AR BRI nT U] e 1 7,
DI R S VR A B B R S AAAEA A AL D, R e PR R B AT AN SRR3R

)

AR RS S AN WA R A AR AT Y L BT A B R B, AU R

UK

FIE 1 LEFEHI A ASDM H, K IREFET B (Tools) > A5 €1T#£ 0 (Command LineInterface). & ~fE{]
AHEA RIS, DMERY G b v e OB HE ERCE s 2B S B LA iy 4 1 5 0

cluster interface-mode individual check-details

IR
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[ ] [ ] Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for cenfirmation, add an appropriate noconfirm eption as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command

© Single Line Multiple Line Enable context sensitive help ()

cluster interface-mode individual check-details

<

Response:
Result of the command: “cluster interface-mode individual check-details"

ERROR: Please modify the following configuration elements that are incompatible with ‘individual' interface-mode.
- A cluster IP address pool must be specified on interface Gil/1l(outside). Or remove IP address configuration.

- A cluster IP address pool must be specified on interface Gil/2(inside). Or remove IP address configuration.

- IPVE autoconfig is configured on interface Gil/2(inside).

- DHCP Client cannot be enabled on interface, Gil/3(dmz1l)

- DHCP Client cannot be enabled on interface, Gil/4(dmz2)

Clear Response

Help Close -

FE WEBEOMAZ G, L 4k a0, (B, W e 7efic & 5 B Dl 1A & 4
FEER (B ans InSEBE 1P b sl )\ DHCP kX 1P #hhl) 2 AT E gk ASA, WK Gk &
WO, DU SR O BCE CMBR . (RSO0 T, B 0% 2450 5 o
CHnR v HD KRB S ORE .

PB2 R E R R
cluster interface-mode individual force

=l
H 2 &R OER

[ Command Line Interface x
|

| Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would prompt for confirmation, add an appropriate neconfirm option 25 parameter to the command and
send it to the device. To make the changes permanent, usz the File > Save Running Canfiguration to Flash menu option to save the configuration to flash.
Command

(D single Line @) Mukiple Line Enable context sensitive help (7)

| |c1uster interface-mode individusl force

Response:
Result of the command: "cluster interface-mode individual force"

WARNINC: Cluster interface-mode is changed to 'individual' without validating compatibility of the running configuration. Please make sure to resolve all remaining configuzat

< >

Cear Response

Com ] om [ e
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for ce it 1 n] 1 #2% 5F SSOB i e A B L B P R BAAAEA MR E . Fials, BHETEEE
ARAT P ) T AT e OV RC B ReAE B Se S E R,  RIL IR AT LAl ] forcedB I, IXAF
RO NI ESE T BEERA)G, B LLEBHZELT check-detail sIE TR 3RS B £ 5% (5 Hl.

WUR AL forceik I, UIEAEA R AFA A EIN, RICUPIREERECEIFTET Mk, N
WIERIEEI G O CnE T D Sk ECE S Y. BRI EES A ER) , W
HR IR EICE . RS TERICE, WPl n i EH G4

SRR RS, M no cluster interface-mode 74> .

$IE3 HH ASDM IFEFi N . ASDM 75 E 887 i3 sh A GE IEM MR E i i, Ehrnds, T bk
7% ASA Cluster I :
3: ASDM EEF 3
Device Information
General ASA Cluster virtual Resources License

Cluster Interface Mode: Individual Interface
Cluster is not enabled.

FEEFIT R LR B R RHTHI R

EIBAT I S22 00, AR R O E — A VXLAN #1105 ¢ VXLAN FIAE BERS B BE IR (1 7F
M5 R, HSRERETIRER , 564 0.

FHia Z |l

Jet BRI B DA T Atk i, DU n] DR A Pt B Bk MTU BB B . 3 F By
S5 ASA T INE. AFBE (Configuration) > % &i& & (Device Setup) > & & (Interface
Settings) > ## 0 (Interfaces) b %

)

AR AR T R R R T B

UK

B YU R0 G P VXLAN PRI 280 (VTEP) %2544 1P Hbudik.

ML R A TEAE S, 152 B E (Configuration) > B A3 (Firewall) > 3F % (Objects) > W
433 % /4B (Networ k Objects/Groups) TUTf, LA ASA Bi KESHCE 8RR ) “ Uiyl 4”7 —i,
VTEP 2 [8] )3l TP W Z8 M7 T VXLAN W5 bR T (VNI $22 28 SRR R BE RS I 2% o R
VTEP P4 AE TR _ LA N 1P Huhik. b7 RN 5 Br HoAth iR B Fg 2, JF H R ARG a6
BEERFEI,

B AsasmmEsen
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R e T P |

$1E2 W'E VTEP Y511,

VTEP J5#5 o — /M RIEEIL S VNI HAH ORI (1) H A SA virtual #2110 LLK—A> VTEP J
PR E A SR S . W IR, DA A4 B s s o
a) WUEHEE > ®&RE > BOKRE > #0O, AEELH T VTEP Y8 8.
b) Mt EIEORZFR (Interface Name).
c) %+ VTEP DO (VTEP Source Interface) & 1EHE.
d) EhERED.
e) MLEERA IPv4 bk,
1P Hl bk W A g 0 SR 2 — S e I g R S o
f) fiitim% (Advanced) EIR, SRJE¥ MTU B8 b 82 O (1 s MTU 2705 154 275,

H T AR T e i R B 0 R, DRI LG R A 42 T 1 e e 008 5 4 e B /N R i £ DA K
SEREREITRY (100 F75) M VXLAN JFRY (54 F45) o B MTU BB 4 1554 5] 9198 7752 [
PE . BRIA MTU 4 1554 “F05 . 88 & & 1500 B, FRATE SO R T BE M MTU %
BN 1654; AT EEMITIR, i 7SR .

Bltn, e B, BT s MTU b 9198 45, IR KB 10 MTU A] LU 9044,
A RES BB AT LA S BN 9198,

g) MHHAE (OK).

¥ VTEP ¥ O 5 W 4% ik 2 (NVE) SEFIAH IR .

a) WKUGEHEE > K& RE > #EOIRE > VXLAN.

b)  CAfEk) R T L BRIAE 4789, if A VXLAN B#risH (VXLAN Destination Port) 1§ .

c) EHER VXLAN 32 M4 E 4k in & Bk,

d) M FHEFiEPE VTEP Tunnd I nterface.

e) ETEBEHRIEEWH A (Configure Packet Recipient) HikHE, it *tZ54R (Peer Group) Hiki#
Hl, RIGIE B R .
f) i Apply.

A VNI 311,

VNI CIBT VLAN B0 BB, I AR, ST B (et e 1 1
AN (SRR VNLBEL.

a) WUGEREE > IR&RE > EORE > #0, KRG AdERm > VNI Q.
b) AT 110000 Z 7)) VNI 1D,

IE ID A N AR RAT

c) HIAANT 1A 16777215 Z[A] () VNI Segment 1D,
M B ID H-F VXLAN Frid.

d) % NVE Mapped to VTEP Interface & EAE
PR EOR VNI #2115 VTEP Y5 LA G

asa g
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e) MiifE (OK), RnmidiEA (Apply).

JEHERRE 0T, USSR E T IP Muhb B O, AR L IR . AR RS 1P
HuAEREAT A B, ST RE AR D R I ASDM M ERERE R BE 1. BT IMbR 0, AT LR
JIEEREZ B2 Sl s BT BT AT 1, DA S BV L B [ 20 20T A R A 1Y A

AT TR B S AR A AT 1 o BRSZ A PR IE R B e e 1, BN N 1P
MBI AR A O TP okl SRR E AR A 1P MuhL R AR BRI s ik, SR T mr IR s i
GIRER{CiiEAmE DV oy iV Ju

WP REE I, BRI DARCE IP bk, AT DA DHCP; A4 B 1 S £f N DHCP skEG# b,
FAF ] DHCP, 2R, MR EEE GES M E & M b 0250 .
FFi&Z |

o (WHE) ME TR,

o XNFEHE O, Ear UAE A ERASHuaE, nr DAd ] DHCP. 01 S g FERAS TP btk I ] ASDM
TREIERE R B O, WA B T A r 24 a0 1P sk AL I A .

o AN RO AR AR Y R b SRR RE TP b 23 LS — A TP H ik

o SERE IP {0 ANRE AL 75 W4 b /RS R bk, 0 AR B 15 4% 1) TP ik
il
1 KPS A E A 10.1.1.1.
2. HAbATSAE A 10.1.1.20 10.1.1.3 A1 10.1.1.4,

3. (EFEMY R RCE A 1P M, AREAEHBME RS bl 20 3 504, BRI O AR
T

4. Rz, BTEAHZM L HAh P bk, 1.5, .64 .7 AT 8.

N

AR MR R AR RO S RS Y SR N SRR RO A R 1
Sk Je T 2R Y K AR A TP Mk

5. MAGEREZ A, 8] IH bR 55T HIOF al T T e 4k

g2

$IB1 KRR BLE (Configuration) > & &R E (Device Setup) > ##& & (Interface Settings) > ##0

(Interfaces) %%

B AsasmmEsen
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rzztrz0 I

W2 EFEIT, ARG AULYREE (Bdit). ERERERS IP (Use Static IP). ASZHF DHCP 1 PPPoE.
IR 3 LRI IPv4 B 1P . MAC Huhibyth R Sk (1 MAC Huhl, 1% &4 (Advanced) ik iR I %

H ASA £ 8% (ASA Cluster) XIS %,

a) AP kb (1P AddressPool) 7B 551 ... SR G SERE TP Wb, R4 /s A 20 Bl X
YT EHE General JEI-RHH B E (1 F TP sl

b) Adiimin (Add).

¢) MUE MBS, AR 1P Mkl AN RIS R SR A ko et Y RN
XFEEREI /NI H LK, Bl 8 AMthik.

[ NaNs) Add 1Pv4 Pool
Mame: inside_pool
Starting |P Address: | 192.168.1.2 D
Ending IP Address: | 192.168.1.9 [_]
Subnet Mask: 255.255.255.04 :'

Help Cancel Ok |

BHed

d) rili#E (OK) LAEIE B kit
e) EFEAIEMH bk IF AT S B (Assign), 25 mHEHE (OK).

Hotilth 44 #xof s T 1P Address Pool B,

0 (Mg (%) WREETF NS MAC Hhblk, 5EE — MAC Address Pool .
PCE 1Pv6 Hhhk, 18 55 IPv6 EI < .
a) % Enable|Pv6 & iLHE.
b) 7E#EO IPV6 ik (Interface |Pv6 Addresses) X1k, Aidii#in (Add).
AFF IR Attt B h BB L
A0k s Add IPve Address for Interface X EHE

¢) 7t Address/Prefix Length B¢, % A4 IPve Mtk Al IPve Wi . filt,
2001:0DB8::BA98:0:3210/48.

d) Sy e S4TGB SRR TP
e) siiiAN (Add).

enno Add IPvE Pool
Name: inside_ipve_pool
Starting IP Address: 2001:DES::1002 =
Prefix Length: 32

Number of Addresses: al

Help Cancel | OK

aHea
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B srsumimsmsmasEs

) BCEELA IP Mkl (ZEHTEED | ATSIC BRI bkt ik
g) MITHARE (OK) LAGIH B Kbkt .
h) EREAIERFT IO AR S BS (Assign), AR5 rHBRE (OK).

Mkt 2o~ T | P Cluster 1P Pool “ZE¢ .
i) MM E (OK).

LIBS fHHAE (OK) LURFIF] “H2117 (Interfaces) 4% o
W6 midiMNA.

EREA AR SFEESIMNERF

FERER AR Y A 2T 5 S REP OB A REIMASE R . AE CREE BN BRI i) — A bz
AT DR T B G B QoIS 2 S AR b € TR DRy I ESIRE R S

Fi&Z |
o TEIEREMIACHNL b, B FAE R BRI 4 1K) VXLAN VTEP P32 b2 AL T84 IR A
o AT A IR IEAE AT AR, v Re ST PR M i 5 B /W TP %, IX 2 TIIAT A .

i

TE1 EF mS (Wizards) > Sa A4EFAR] B4 ES (High Availability and Scalability Wizard). 123
DL DB AT DCIE B ) IO UEN
1% 2 £ ASA Cluster Configuration bi#EH, ALE S| ST RE, W

© BURILFELR - BEE I mUH T RIE2S A S, HAEVE Y 1 2] 100, L 1 4ot
e

« S E S| (SiteIndex) - U R A T ot s TR AERE,  DUDSE A HE Y A N 1D, DA BB T i 5
RrE ) MAC #iiE (AT 188 ZIRD &

o (gD HEZHA - WENE P USRS R B IR KN T 1A
63 NPT LI ASCIL 745 i o IL= s PR s s . S A M A AR i
AR 2 DL SCRGE I BRIR A SRR AR . Wi RS0 I8 I 1 SR s Ik g%, s 25
BEHSH.

+ (H[#%) Enable connection rebalancing for TCP traffic across all the ASAsin the cluster - i H
R BOATEOLT, IS THERPIRES . WR OB, ASA SRR e A #ie 1 4%
fER, IR MBIBOR B HBT IS RL I B B B . ORI 1 3 360 £, T
58 2 KIN A e R BE R . WS EOFAES | SREFECE 35, M A IS S A2 2
CTRED S I

B AsasmmEsen
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ERsTAtnstgsnags: [

pE s TH2) vl 5 TR 4 C B R P M s AN SRR PRI BT T Rl B
JE D

(A1) Enable health monitoring of thisdevice within the cluster - Jii FIAE RS s TR AK A
Thig. N THAE T IS TIRGL, ASA SERENT RIS TEAERHE HIRE R [FF heartbeat W 5L & 1% 2| HiAth
Ao WU RTAE LRI P A BRI B AR T SR AT A heartbeat T 8L, TUSHAEAT S04 T
i B 5 G 1A%

pE s A R AEAT AT U CB s s R A4 1 T AR ] ASA BAZHAL 11
D, ARSI A, JE A CA IR LK . R0 &
P e i G B e B B sm, BrT LUECH R Rl A RO 2

R EWAAER M Z BT A #5618 (Timeto Wait Before Device Considered Failed) - 8 T
fff 72 15 £ keepalive RSV BV RIBR T[], wIBE Y 3 245 F0; BRIMEA 3 75,

CriE) EHEH At - 8 KT s BEHT SR H G 6. BOAN O N AR )

o X TR RBEEFAIE, ASA W EEEAANH BRI HI G . WREH T sl 6 = H, Adk
TR G W S ROR B A IR SRR N G i 1. kS HOFE
S FRERCE N 8, A AR SR B R

* Cluster Control Link - $& & fER A I BERE B 1

* MTU - f5 € VTEP #2 1 5 K AR 547 28 /b b 3o B2 1 (1) dse sy MTU 57 154 21 TR
R R S EOR e A, DR LS 2 T o 5 2 R A A e M/ N B L L K
R ETITAY (100 775 F1VXLAN JFRY (54 7795 o ¥ MTU & N 1554 #9198 7745
Z IR E . BRI MTU 24 1554 745 o 43l $: LA E N 1500 I, FRATTEE SO S FE 4 1 B ek
MTU % &0 1654; ST EEMWTINEA . Flr, A4H B, B85k MTU 4 9198
1, ki R O MTU o DUE 9044, i SERERS HIBERE I i) DLW B 9198, LS5
HAEG I PR PO E 55, M AT SO By T B SEE WA
A ERMWRE, NIBH S, JHHERW, AR5 F R SR .

$I2 3 1T Interfacesfor Health Monitoring e I, #0] DU Rt — bz O E Tl i b . sl BEARZR TR
FEE L (B R D s RO

pEEd DR S AEAT AT SN s I el B A e 1 R YA T ASA B S L L V4
FD R RIEATIRAS KA, IR SEAEHI AR LR A% . 3 b Sy B
SECHIECE E S ERE B P mUn, B LLEE R Fs RO 2

IR 4 7£ Interface Auto Rejoin settings i 1, [F 52 AR 1 AR TR 1 B A= i s I 1) 1 sh BB A
BOE . X TRERSERY, AT LABCE LR 2L
s RAREFIMANSIRE - 3l BB TR T~ 0 3 65535 HMH, & SCEEBT ISR 2l
O R 25 ABEF I . X AR, BRAME ) Unlimited; Tz b, BRIMED 3.
* EFINERE - W i EAN T2 2] 60 PRI, SO UCEDET AN 22 8] (14 18] [ 55 2 TR

CPAAT R i) o BRIAME 5 8. 5 2R E B N SRR A0 o K R s TR FR AR A B R R
Z W2 14400 2050 (10 D &

asa g
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* Interval Variation - @t ¥ & AT 1 2] 3 1 MRIBRARA, @ SR FREFLERT AR B 1 (AR |
2 CLARFFEEEIM 2 f5) 803 CEIRFFLENT I 3 5D o Bdn, o Ak [ b FF Sl i 1) 3
h 5o, IR RSN 2, WITE S R RHTHE 1 IR 76 10 208 (2 x 5) JEHEATER 2 K
Sk 7E 20 0B (2 x 10) JEHEATER 3 sk X TAERE L, BRMEN L TR, R
IEA 2,

HIBS iR
FTIE6 ASAKHARIEAIZITIE, ARERANLFNIIREA AN S, AREEIAECE b o ReELE iy
A ST MR ARG A, Wi S meg, WS S AR,
2t —BNT S, 24 ASDM Ji AR E03nd 82 8] ASA I, RE0K E7R Information JE4s, ffiiA
ASA CNINEIERE,
TR FERLURERUR, SERUn S a I SERE 1T e tHBLAR % . S ASDM Wi JTi%4%, ASDM
ANEWLFR H ASA AT )G 928 . W BHiE R ASDM G SR RAE, Nk s
ASA PG B A 2 25 SERE I FAREER T O, B, SERE I BERS nT BE 2% 1]

TR ERINEIE AL R

U R Y ) EPTEAT T, W RAAE O 21 1) S I UE 5% 1o R B 78 00 L b B SR TIOR8 in i
R

12 8 7F Deployment Options X1, M LLF Deploy By i1 H k£ 1 T :

« STENENBRFZIR & K% CLI 7% - 5| PAPHC B AL B HAR Y AW ORI B39 1P Hudik. B
BRSSP k. FH P AR,

* BHERH CLI FahEH FMMELERERE L - A pkiar 4, DUEST )RS 20800 7 55 CLI 8%
7 ASDM H{fi[f] CLI . H.. 7F Commands to Deploy & iEHEH, MEFE IS HIAE iy 1L RS 5
i

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually 3

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet(/4
no shutdown
cluster group clusterl
local-unit asal0
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-data-node- noconfirm

B AsasmmEsen
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arvEszt

= \Y A= B 4D
B ENMEERE
YERNEE 0 RECE )34y, BiEEMEERZ )G, Balbl 8 e VERGSITIRGLEE . TCP EEE H
SEIR . A BRI H AR AL
LR S E AT IX SR .

A EE A ASA £8 5K
BT DAY f b A SCIERFCE . RN 1) SRR T A I 2B R, mT AT Bl e B 4
SH. WARCR SERE, T AGa SRS 0 AR I JoiE g iR i) AL S B I . AR
PR 17 3 AT K S
FiaZ |l

o WEARGEARAT 2, FFAETAIAGERE, W EAE ISR 2 AU AERE AT e TG B A T
HIRERS . 1S PR Y S R AR R RS . 2 14 0L

UK

P KKERFERE > R&EE > S RAMMAT RN > ASA £5.
WA I e ARSI b Ho #7520, LA ks (e S B¥ECE (Cluster Configuration) 3~ |,
$I® 2 % Configure ASA cluster settings & iEHE .,

RO E T I SRAE, BRI BERR . ERCE DT ST, Wik S5 ASA &8 (Participate
in ASA cluster).

iR JE ARG, WEIEA T 85 R B0 R EGH &+ Configure ASA cluster settings 5%
HEo UEHAE VG BRI A SR B OC T A He 1, 4G ASDM B B 1 . 7EllE
LR, BEAERE, AR 6 o 1BV CLL

FE3 BLELL T 5 SRS AL

* Cluster Name- &R 4 . AV AUERKEN 1 3] 38 NFAFFH) ASCIL A48 . BN M A BE
BOE —ANMERE. SRR T R 2 H [ — 44 B

* Member Name - fifl ] M — ] ASCIL 74 # O PLAE I S w44, QL2 1 3 38 77T

* BUSMRSELR - BB U TR RO A IARSE S, FUE T 120100, L 1 il
e

. 15‘5 25| (SiteIndex) - S a4 FH ol s g AR, U5 g b A e Bl s ID, DAL A il
FEEM MAC il (A F 188 208 .

| asa g
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+ (WiL) Shared Key - B8 I o P LU ISR IR T HERE BV E . LMY KN T 1

A 63 ANFAF LI ASCIL 745 i o JEEF P T ARSI E # . WS EA LM S AR
i, EAERIRA DI SORIE R IE RO SR M R n . REIE IR T3 63 g ik 55, il
LB S

(FJ#k) Enable connection rebalancing for TCP traffic acrossall the ASAsin the cluster - J5 H

R BOEOLT, WSEAE TEERPRGS . WS EOTFES | SRPICE R 7, M
P SRR Y SRR R EH . ASA S A A SRR IE NG R, IREEEE
e N FD AR 2 (B35 0 T B S BRI e % o LA IEHOKIEA S8 3. Mo, BT Iy
AEE T RERD AT BB A, DA S B R B LI S, O HE
SECATRETEAAHAE o IR IE R 1 3] 360 #6, HTHaE 2 K A2 — R8s . BHAMA
h 5 Fb.

REERR RPN S5, SR O AR FRE R

TH21 0ok s TR 40 SR G EE B YT SR BORERT IR B 17 BT AN R 3 s X SRR

AR

BB S B EEEE - S nT DU PR SRR Il o U 03, A R B, CPU AT A7 A6 I B0 LA
LM IX EFF e MRSy, LR B T AR B A0 38, 4T DA R AE 1Y il B Tah 2l 4k
BE, B HESNRAC LB Db . BOASOL T B AT Ehae . nT DUS s 8. W
KAt m, BT LOEFET BT B SER

BEELLMME:

« BFE) (B PR — W E PR IR R Z TRl ) CRARD ), JEEEIA T 103 360 #b 2 f0). BRIA
ik 20 ¥

* [BIFREY — BUE ASA HE AR BRECE, T 12 60 21 BRI 30.

W2 %42 (Monitoring) > ASA £ 8% (ASA Cluster) > £ 8# {1 3 445 (Cluster Load-Monitoring)
DAEY B i i 728

(ATk) BRASERNIZIREIEITIRRSE (Enable health monitoring of this device within the

cluster) - J3 AR RUSATIRDUR A D) B8, JEAfE 15 RUKIE heartbeat JRASTH B R 1B ] B,
JWHAT 3345 B2, BOMER 3 8. JEE: EREREP ARG 5 L B ASA SISl
RGN, NIRRT RE, HEISERE GBSk, WA DA D s (BCE
> REEE > SR B > ASA £8 > SEEHEMETRR IR, ErI DAL
PN T e e 5 TR FH IR TR O T #fE 1 RS ATIRI,  ASA BRBE Y RS RS I
1K heartbeat 1 E AL B AT mo U SR RUZE DRI Y AR EIK B 645 4Y AURAE T heartbeat
RN, DNDRE AR AU A T R Y BTG 2 A

CRI3k) B BRAT 8] - FC B ASA K AN A A bR 1 sl IARTRE N Bk 2 i el 1 197 e il
IFIA) . SHE D BE T LIRS P PR B o R, SR C 7 B I [ AT, e 88 i3
ILHR FERARL LRSI, ASA SAERHRE M2 0AL AR5 A K45 DARIC o A B s,
T NS BR . BRI AR S BB ()2 500 2E4%, %I TRV 300 22702 9 75

Cr3E) EHEHI M - KT i B SRR G . BOARTOL T 4R )
AEo X THFERBEFAF, ASA W EHEHICLIH QA MBS & . WA I 7RG W, HdE

B AsasmmEsen
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TR G W B AOR B s, DI R SRR 1N G i 1. ESHOFE
G P RERPRCE K — B, T AR s SR B el s

« (n[#) Enable Clustering Flow Mobility. i&Z: Rl & LISP kil , %5 27 T,

« (A1) EnableDirector Localization for inter-DC cluster - > T 4 & 1tk A FE /b Hedh oo 1k
AU BRI A IR IS T REIR , 0T DUS P I8 A oA o BT Feil i 83T, A sl s Y
ERRE R T o (RS, ASA 3 AT 3l UK A A0 L T 25 AR £ . 3 ] SR A HB AL SO A
a0 5T 3 Rl s A 3 () S A AT R0 S AR T 88 BT 3 R T ) 2
TRl AR T ERE . JIAh, WGP RN, AH 3 () 28 e W B[R] — 3l 0 A
BRI . R R JE T A B B R A, AR T A

o (HHE) SHRITUAR - A ORI Aol fOMRes2 i, ] BUS I mO0AR . W ABER I &0 Tty
BHPATEAL T vl m L RS Aol LR NN &4 B AT 8 R ORI U i S 3
SRR o T ) s A AL A, RO AN DI RE s T ARCE R —AS, sk RCE P

(") BABRERDSINE - 815 Al GG S ECE AN RN, R GUR B CE [P A,

M INBR DI SERF R o BROANG OO T I I DI RE . DI REAEREAN T AL BICE, Ao IFEHIY

s S B EE Y R

iR FHELCE Ay A IR IR W P AR IR Sy 4, R O H s
LR, WAL I E R . OB AR A RS, DU R IMA T
. 1#iH show cluster info unit-join-acceler ation incompatible-config & & AN 25 1
[

* BRFTEEES - o M ml LS B O TREP IR S AW, Rt 17 m 2y,
HF Rl AE TG ZEAL 9 2 N )

* Cluster Control Link - ¥5 & SR il s B2 11
* #0 (Interface) - f53¢ VNI #£11,
* IP Address- §i 2 TPv4 Hubib {104 TP Huhils A% UANSCRY TPV6.
* Subnet Mask - fi7 & T i .

* MTU - 455 VTEP 4% {5 K AL i Ay 22 /0 L Bode 4% D B MTU & 154 7735, i T4E
T4 I B B U e S B 0 A e, DR S A4 1) 1 5 22 R A 7 AN S0 3 /N PR i £ DA 2
LERERETITAY (100 775) F1I VXLAN JFRY (54 775 o B MTU BEE Ny 1554 #9198 7745
Z I BRI MTU by 1554 775, 3R T8 E N 1500 1, FRATTE 0K B8 T s ) i
MTU % &N 1654; SAETEEMWIEA . @i, ZEM0H B, 15Kk MTU 24 9198
A1, DR AR R T MTU A LU 9044, TSR B B ) ] LLEEE h 9198, B4
ARG SRR E I —3 5, T NS 1 A S B A . SEE SRR A
S BRI R, e BT, AR5 EEHT I SRR T

$HIE 4 % Participatein ASA cluster & IEHE I ALERE
SIS sl

| asa g
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B =ssozarsssstansmnags

Aic

ROBITRSBEFENENRMANRE

T REAAE A R R 0 (WA B 1D iR & I8P IRBU RIS ANE VLAN 7% 11 E
PAT . RN R T RE R O B A B TR RS

FHIB1 KL RELE (Configuration ) > X & EIE (Device Management) > &7 I 4FARTH B 14 (High
Availability and Scalability) > ASA £ 8% (ASA Cluster) > & 8#E 1z {TIR L 442 (Cluster Interface
Health Monitoring).

P2 MmO, W —NMED, R AERR, IR BIR EERE O .

F2 VIR ST BB A I B B i e o 2t SR A e AR R I ) P A B2 IR ASTE R, T ASA MAETEHH )
B3 3 2 Wi T 263k R s ) B e T e DL B S IEAE IR . BRIAE LR, AT D
A FIE AT RIS £ o

Al REREZE AT B 0 (FIHnE LD KEiPRuEE . SIS VLAN T30 I
PAT . BASBE N EERERS BB IR I B N B A T IR A

élﬂii‘l‘?’yti@cﬁﬁiiﬁﬂlﬁ G s B 72 11 . 3 FHEAEH] ASAL BRACHAL EFE ), 1
R EATIRSKR AT e (BLE (Configuration) > & & &I (Device Management) > & 7] FTEF0AT 4

EIEE (High Availability and Scalability) > ASA &8 (ASA Cluster)) s IREARAIN O OB O

WA o 3 S5 T e B HLC B S LRI BRI s S, 0T LU S I IR GRS A D fg

T3 L BIEFMA (Auto Rejoin)iZ I, LhFE SCAERE 1 AR GUsUER VIR A b i (1 1 30
FOFTIIABEE . X FARERSRMY,  midi gt LA E DL T LE T

BAEFHMANSE S - 0 S FTPREA T 0 21 65535 HME, & X EH AL A 2Rk

OKZEH A ER A . M TEMNZD, BOMEHN Unlimited; XFFE#EE O &S, BAMEN
3,

.

EFMNBEPE - WL B ENT 2 2 60 FPITRFE, & SR EHT NN 2238 2 18] (14 1] [ Fp S i )
CPAAF P o) o BRIAER 5. 15 2R BN N EERE A B R R i) TR PR R4 B R R
Z I 14400 2% (10 1) &

3

Interval Variation - i@ i ¥ & T 1 21 3 B MRIBGARA, & R FREFEERT AR B 1 (AR
2 CERFFEERI 2 £ 803 CRIRFFLERTaI 3 /%) o Ban, i S AEcks [ b FF sl i) e 5
N5 ol IR AR BEE N 2, WITE S R RTHE 1 RS 76 10 208k (2 x 5) JEHEATER 2 I
Sk 7E 20 00 (2 x 10) JEHEATER 3 k. 0 TAEREE L, BRAEDN 1 X TR R
e, BRIMHEN 2.

s i BRAE AR BRI B

FIE4 it Apply.
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AL E 8% TCP EHI3EiR

4 TCP 4% J7 FI A B 1R A B T2 3R A A 5 1) 2/ A A B Ha i, AT 4 53k 55 R0 SO 50 A O 1)
CAMBTAE” o EER, WIRREAN R AR T 28/ A B VAT IR, e X e
e [RIFE, 0 B e O @ O Ty PR S8 2 A %, WIJEIE RSB . AN DA
TCP FHLAL )9 5 F TCP il el o

UK

11 EPREE (Configuration) > R & &2 (Device Management) > & A] A4 F1AT# BB 14 (High Availability
and Scalability) > ASA & 8¥ £l (ASA Cluster Replication).

PB2 SGERIIEE DL RE:
s EHIEIR - WEDE, JEHEAT 13 15 206,
* HTTP - W& P HTTP M s LR .
< REMH
R - R P bk
* Service- (RJik) VBV o I8 A2 BE PR B H A 1, AN W I 3CE P .
- BFRFEH
R - WE HbR 1P ik,
© BRSS - (Arae) VO Hbwum o 3 B Y s H bR L, A R RCE

T3 LLE.
T4 rGLNA.

Be & ub = B T BE
XTSRS DL s SRR, DL U ARPERR b
EERAFREEE
g5 B 2 VRSN, 65T BLEYAE LISP U LU TR 3t

% F LISP #&:)
AL LISP i,  DMEAESS sl 8 AT stk .
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*xT LISP

ASA LISP 37 5

LISP #E)

ASA LISP 52t

AsA g |

IR B o (NI S ME (i1, VMware VMotion) , JIR%% 28 AT LAZE B thob 2 i, [R)
Yekr HR P unER: . T SCRRICEEIE O RSB TE, B th28 T EE AR A1 IR 55 45 F5 B I BB
WAE RS 2N B o JERE A7/ID 43 85 WS (LISP) ZEMPE ¥ 48 5 4 BE 2 AR IR AT (EID) 5 % £ fir
B B EL T (RLOC) 23 57T, 00 B 21NN g5 23 0], SRR S5 28 1T A %55 ) iy 140325
o BT, RS FHIT A BB 0 s T 5 i 1) IR 25 28 KSR N, % R 2 2 K U o T R BB
.

LISP 5 278 2 i 1 (1 % i as AR S5 4, 40 LISP W IR IE B th 8% (ETR) A I RS IE B 4%
(ITR). Sf—Bki% thay WU NS (MR) FILGT ARS8 (MS)o 55w 1 58— Bk % b 2 A 380 e 45
WER T HADES s, e ER T HAL K has AR R, DUEER R P i ITR nf LAk
R TR P TRt R ML) &k VAW

ASA A EHARIZ4T LISP; {HSE, ‘& nf DL A LISP Wi i 7 B 50 e, R0 1 s 3T 4%
R . W SBAME A LISP 45, M4 a5 A2 s BHmul sy, s BIA A7 T8k £UK ASA £
B0, AN RIR MR A ¥« Hr ASAKHR B R B IAGE f) ASA, AR5 IH ASADAZIUKRt 2 & [0l
Hri o, ARERIARS AR . WRRRTIFARL T RAERE, By “K57 3 “R¥k” .

AT LISP #E1k, ASA BERERL 3 n] LUK 25 2 — Bk th 25 5 ETR B¢ ITR 2 [A]ff) LISP ¥, AR5
BT AT B A T

* ASA SRR DL AL T8 — ki 8% M1Z RO ITR 2 ETR Z 1A, ASA EfEA G AR/ A Y
JEE R BRI 2R Bk s o

* DOZFRE e ATBE i R BRI AT e T AN B A S B s E B B
% B EAE N (Bl SIP) A R SR I E 1R ASA T AT 1

« SRIFUZ N 3 MIZR 4 JZ U0 — e A rTRE 2k

o 05T RSN AD AR AR B TR AR S Y 35 Bt i, BTy & T R AR e ek . AR E A A
SRR, ST DL DD RESCRF I 2R, IR FO0S i E 3 IR AR A Bh 1k

HIh e 2R B OCBE I . (REBE — U] -

1 (afik) FET MRS 28 1P Huhik B AHIR 251 EID - 55— Bk th 28 il e 23 1] 5 ASA SERETC 41
TEHLE L% A% EID G A S, Rk, ] DABRH a5 58 I SEREAT S IR IR 25 2% 5l 4 2% & 324
EID. iy, WnSEERE & 2 ANk, (HJ& LISP 75 3 Nl i FisdT, N AFEEERE K11 2
AN 35 EID.

2. LISP il E AL £ - ASA £ UDP iy 1 4342 ) LISP Ji s & AL 28— Bk i 2% 5 ITR 8 ETR
Z I RIE EID JBANHE . ASA i35 — /K EID A1yl 5 ID AHSCHA EID K. i, R
P 25 2 — Bk Hh 25 U5 TP Motk DA K ITR o ETR H brHuhikff) LISP Jii & E =, %A A LISP i
HOMAC T RS, H LISP A B A S HERRRE L,
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BLE LISP #2:)

Nil

B

rzuspian [

3. TR IR € Uit (KRS S P 1A AR 55 SRS - S ek SRl 55 i s sk o ot mT AR
Xt HTTPS it A/ el b 36 By 5 Mk 55 s 1 5 T iz s ik
4. uhRi 1D - ASA A FIAEME A RS AR 2l i 1D B E B K T AT

5. T RHRB S PERERESONICE - ROCBAHERREION A MR s BEIT/ ST fo VR
S st i A P e SR B LRI A sl

MRS AR AU R Z RIS BN, SR LU & LISP ittt LUS AT Zh k.

FHia Z |l
o ML EFEA ASA SRS HL, 21 T, AAMERR A L — ANl R ID.

* LISP it i A& 7E default-inspection-traffic J5H, Kk, ETEULIE AR h 2420000 LISP it i & 5
AU SN

Bz

(A Ml 'E LISP Al kit DUARPE 1P Huhik FR IR F BID, JRHCE LISP Wit =254 .

a) WKUGEHECE > B > &R > MRS > LISP.

b) A RN LA HT g

c) WAL (% 40 NFFRF) AR,

d) WFRIFBEIDFEGIR, SHEE.
RYK+ I ACL Manager .
55— Bk th o ITR/ETR ] AE 2 i) 5 ASA EBEJC R LML M 4% 1% EID I 409 5, Rk, &
AT AR I i A8 AR SR I IR S5 s a4 K6 BID . i, dn RAEREAI A 2 ANk i, (H2
LISP 7t 3 ANl 1 BigqT, MR &) 2 ANl i) EID.

e) MRHER K EEHCE F5 A N H A 22—/ ACE () ACL.

f) R, HMARIES.
TR T AN S, 1 S B R A A .

g) MiifAE.

ISR 55 S5 s U] DAC & LISP Aoril -

a)  MKIRIERBECE > Bh A S > BRSS SRR .

b) A,

c) {ERRSSEHRBE VM I, CKEd Y #4eE O a4 R N .

WERAEAT ZAG I AT IR 55 M, W5 iz SR AR . BTG 0L R, ASA Wk
global_policy 4R skg . dn SR A7y B4 JRy N TTAZ SR, 38 ] IO RN B8 — MR 55 3R
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d)

e)
f)

2)
h)
i)
j)
k)

AsA g |

W&o LISP ASIN 2 X n) B FH -9 i, DA R G F 7E e VR H bz 11 BN IR 25 Skms s G SR
TSN 1) B S ARUCHL ,  DU)3IE N B3R A 8 PR I P2 1 PR BT A AL A2 S
EmENEFREIN F, shtl@FRESR, R)ETERE TEARAE NET IR B |P ik (E
F ACL).

J Rl et 2

PR BRI It . BN AE UDP iy 11 4342 FFg e Bk 8% 5 ITR 8¢ ETR Z [A] )3 & .
$%5% IPv4 F1 IPv6 ACL.

JE Rl Nt 2

TERUMIRAE ) I EBOET R b, EPESa &L R,

W LISP HikHE.

(A pil e & LR B0 2 A DU o)

il 58 B PATRAE IR 55 SR ms )

IR WIS MRS SRS RN, O A R A Bk

a)
b)
c)
d)

e)
f)

2)
h)
i)
j)

KEPFECE > B A3E > BRSSSRBE AL .

MR

TERRSSSRBG UL L, BT LISP KL i) [ — IR 45 S

EmESEEIN L, mhtlEFRESR, REERE REimE Nk iR B R | P k(5
F ACL).

M=%,

i R AR 5% 2% B ety I, BEEDE G A B il L S R . i, s AT DLE G HTTPS
DR AR/ R B Ik A% A L A R Bt . #5652 TPv4 Fil IPv6 ACL.

MiET—%.

AEMMARAE ) T OO BET R L, EPERIETR.

% BB LISPEID jE 2l A M ERRB ML LM

il 58 B ATRAE IR 55 SR ) .

TR A RUGEHEE > REEE > SRR BIE>ASA &7 > SHEE, Ak BRAKEREH
PR IEHE
FES rGHNA.

T

BIEEMT

il

Oy

[ANY

FARME IR, AT DA O R BEARARE Y R

MAZHI T3 2 NN 38R 5 =

fan] DUAFS T ) SRR LAl 55 15 5.t nl DM High Awvailability and Scalability 1] 31
BOPEAT s o I A B Y 5 R IASE T, AT DAC SR R I O 1 S N AN B
P R AR R

B AsasmmEsen



| AsAsrrmEsn
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B, A R DL RS Sk BB T RO BRI R B R AR . (FRAE RIS, ASDM 231
Wb, BB

FHIa Z |l
o WURGEE I B R SOR T PR ICE,, T ORI T S B R U5 R TP k.
B2

P KA E > &FE1E > S AMMe Bt > ASA £8fF > S8l A.
FIg2 i Add.
$IB3 E LI FSH
« Member Name - 1 I "E— ) ASCIL 7757 5 4 AR Bl in 4, KN 1 3 38 N4
o BRRMLSER - B I S TR kA e, HAYE RS 18] 100, 1 b st
Ko
* Cluster Control Link > IP Address- byt pk 2 15 e ME— PR ER il BE i TP Huhik, JLA 20 il
REPE Y=t I VAn Rl i R G SN
* 7t Deployment Options X1, MLLF Deploy By i3 -5 — ANk i :
« SANENEFRIRF AIE CLI #5% - K59 | SREFPHCE AL B 1 A CIEID &2 1P Hubik .
HONEE Y SR TP Hbk . T s Y
« BRI CLI FHhEH FHMMLRIRRiIgE L - A4, DUMEETY) IR 2505 55 CLI

rhElfE ASDM A ffi i CLI 1. 7F Commands to Deploy & IEAEH, 3604 il A= i iy
AR SR

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually =

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet(/4
no shutdown
cluster group clusterl
local-unit asalo
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-data-node- noconfirm

PIE4 riili OK, #RJ5 siili Apply.
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MRAIEFRET A

LR ERFRARTE SN AR, T R EAEHIARRE,  [FIN OREF R E AL

\}

AR MASARTARNGSPIRGS (T35 NI RO 2RO I8, BT Hudle i AR el A
L R Ol UAGR Ao b . B A AR, i BB R AR B, St T DUNERAE 5
SMIBRIZAT R BB TV ORFFAT T, A RO ERAE TP Jthago i TP e (EAn R A B 2k,
I RAAEGERE AR AR ARG (P, G 0RAF T OB ED |, WA BEER FOR 28
A AL 271 65 e T R EATATA E 2D L

UK

TR KKEHERE > REETE > SURAMMTY RIS > ASA ££# > k&,
P2 WU AN ASA SERESEHE.
pE s I BGH LT ECE ASA SRRIIRE IR, BB IS BRI SR B R P R A,
A ASDM LRI HAE L AEUEIG 0T, SRS, e B 6 v D7 1)
CLI.

FE3 rGNA.

MEF T RERBET R

T AR S, ESHRATEL NP R

)

AR CYASARTARG PRSI, P BE R D O] AR L AR LT USROS
R, WERTR SERE . B LR R FFATOT, AT ROMERRE TP i 1P Mok, (EAn R AR
BN, W SRR A T AR APIRZS (B, Bt fifr T E2S AR ED P E N
AR o R U 2 R0 5 i R EEAT AR AT 20— 2D L

UK
TR KREREE > REEE > SATRHMEMAT RIE > ASA £8.

PIR 2 P LR E Y R KA R RR
s 5 SRR B O ANAZ, DI R] TR e BRI Iz Bl 19 mm A o 2R
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sxmakz ]

$E3 SN A.

EFMAEEF

3}

i

RN IR T2 CETnEE e MBS 132 1D, s W R T ahs ) T 5 b,
AIELIRT- BN EFIMANGER -

UK

WRATAT ASDM Vi i), #AT LLE IR ASDM JERE RAREL TR /5 A RE 1 0, /£ ASDM P LR
JREE =i

TEANRE T ¥ Dy Bl 1 R EHT I TARAE BRAEREZ M B85 I A T 1 57

a) MKIXERFRE > BEEIE > S AT B > ASA £,
b) AN ASA EREEIEHE,
c) AidiRA.

WARBARAE ] ASDM: e85 G 1, HEAGAENC B
cluster group name

-

ciscoasa (config)# cluster group podl

Ja AR
enable

R IR AR, TEMPREAER S SRFICE . BT R S B ARG E AR OA T B
25D, DGR AR LR R A NS O IR AT L, AT BRI OB R T 4h e &
PSR TP ik 5%

UK

DS CIT NI DI E ST

cluster group cluster_name no enable

i
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B

ciscoasa(config)# cluster group clusterl
ciscoasa(cfg-cluster)# no enable

FERCH T md R AR, S TCvR AT E B S

IR 2 IERERICHE
clear configure cluster

ASACRERMI P A I, AL BLRE LORN R T B o
TR 3 SN A DA

no cluster interface-mode
B T RO E S, D 2 T3l .

TR WA SOECE, PR I E S B EAE IS AT R E
copy backup_cfg running-config
-
ciscoasa(config)# copy backup cluster.cfg running-config
Source filename [backup cluster.cfg]?

Destination filename [running-config]?
ciscoasa(config) #

SRS R E DR AF 2R B BCE

write memory

PER6 WORBA A RCE, WHEBHEE VIR B, w0RE e o 1P deht, IR IER BN

B SR HI T
A

ER B SR A, SRR TIE AR S LA RARRE, SRR R I A S PR A R AR W
SRR E BRSO BT RN A 1 AT R IR . (FURIEE R, MR IhaEI S,
A AR P ot bl B A Y s BT AR T, i R b 20 AR P 1Y FFT e N 2

B R L TEPATEL T PR

UK

FIB1 M IKiEFE Monitoring > ASA Cluster > Cluster Summary.
P2 N FR BRI BB B A B AL ARG R I SO P Y R
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EE

$IE3

T4 ]

rergemnEnnEes |

REKG PRI SRS SR
B ASDM, SRJGEF - RE TP Mk 5553,

ENERRSER AT S

B AR RE R BT A AN B T S R AE A, EPATUL N IR A T 1Y s k% show i 4 LA
FE T S TR 3L R AT s e b T AN SR T AT HoA Ay 4 (i capture
F1 copy) -

FiaZ /i

AT I LR FHAT AR fKIKEFF Tools > Command Line I nterface.

UK

P& AR BT R, BEE WURTRE T R PK,  TAIE BIRE 5 1Y 5

cluster exec [unit node_name] command

T

ciscoasa# cluster exec show xlate

BEEEFET LR, ER cduster execunit ? (Al 2 B 24 w0 S ZAMATE 485 , Sl show
cluster info fiy %

]l
L[N [] A SRS R B BT AT i 2 TETP 55, WEAEREHIT A B A LR
FIIJ/?\

ciscoasa# cluster exec copy /pcap capture: tftp://10.1.1.56/capturel.pcap

Z /N PCAP SCfF (— A3tk H—AN1T 5D 612 TFTP Ikss4t. HAriR X% A3)
BT 5 2 HK, 2 capturel asal.pcap. capturel asa2.pcap 5. fEAKIH, asal flasa2 E4E
T AR

153z ASA Virtual £ &

T DL SRR PR ME BT HRER bR
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VR =: E ) HA
IR EERFINTS
IEE DI GGl S RN
© BS¥E > ASA R > RRIRE

SR T A% Sk s AT O B R A e USRI R AR SRR R o R0 mT AR L B o S S
Ko

* RS ER
FEE R T ITL, T DU PR A2 T T ASOMI AR 17 X e 2 1 T AR A B

HIRBENRECEE NS
A RAEERE TR B O AE R, ES LR bk
Wizards > Packet Capture Wizard

LSRRV R (R OB FR I A0nT ARSI st LS R e R e IR R I D e, B S SRR P (o
AT R R R e .

B>
PR
H3}
i
i
9

TH 2 LA B DL 2 SR T TR U -
* Monitoring > ASA Cluster > System Resour ces Graphs > CPU
ST R AT T G s T SR RE Y 1 CPU A A 1 B ek
- Wrim > ASA S8 > RGEEE > 7. HLEHG AT T 00 R T SR AT AR L P

FEIHEE.
HIERMNE

TS LT B DU P S R
* B54E > ASA £BE > REE > EE.
LB RS T T B s P A SR AR D R JET ek
« EE>ASA KB > REE > FHE.
Wb W] T G S s T AT SR A A 7 U B A ) P B
* B54E > ASA SEEERE > BEfA B INIR

KA R M E BRI SIS B A . RIS B R RT — HE SE
PR A, LU DR R R GRS T 0 30) o M G s IS S B T B
AP 5] 1) 5 1 A A
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T SR B I TR
ISR IO, ST R R
Wi > Bt > REARE > EEHEHISE
B 0 1T 7 B BERM 2 L TR R B

RAg Ak e get
A REREBR MG R, 1S B LUN bR
* W5 > BEH > LISP-EID %
78 ASAEID %, & 87 7 EID Al £{ ID.

BcE &R HEIEE
AR R, 5200 DL B
RE > REEE> 2% > REBSRE

wpanmnsn ]

SRR AR RO O A AR G H S R BT DR AR SR AT AR AN R 52 1D R S8 H A

K DI B Lk A ARAE P AOAR R A A4

ASA Virtual &£ 8 7= 151

XL % SR P R AT S ARG ASA E

J0 4% O R AR Eg AL uh B SR RF 71

LUR 7RG 21K 2 A ASA SRR s AL T 2 AN EEAE N B A T Eik h # 2 0) CREESAN) 15t

e ARAEY ROARTEIZ I BE BRI DCL IR AL TR Hdh w0 fK A AN A1 B % o 24 ] OSPF

H1PBR £ ECMP {EHAFE 1l 03 2 [P B AT S804 T . S 45 52 DCT H TR RS e R b m R

RSN LN BRARS ol i LRI ASASRIETS S rh Wrii ) o iR —Auli s BRI
AREY R A E W, RS BRI g8 1 DCIL AAE Sy — Nl i) ASA SRS .
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T
r/_ P N __\
E;\ Internet
Router e SRR g Router
S
Higher cost route f_,_fo
C QOutside )
-
Node3
Data Center
Interconnect
o
{  Inside ]
W gt
e Higher cost route Higher cost route
— .
Router

Data Center 1 Data Center 2
ESX

AR B RER TR RPN .

L\b kY +

ASA T FREERE

B> ASA ThREAZ ASA SRBESCRE, A0 DhReANAEFE w1 s b2 3 ke, oAt Dy R nT REXS 4] 1F

A AL e T = I,
SRR

LU DI REAE 3 FARBER IGO0 R ICVERCHE, ARG & A 4
* WKAE TLS ARBESEHLIN & — 5 T fg
* TRV VPN (SSL VPN il IPsec VPN)
o MEAUBEIERL T (VTI)
* LUN R TR #
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* CTIQBE

* H323. H225 fl RAS
* IPsec %%

* MGCP

* MMP

* RTSP

* SCCP (%) "3ifi)

* WAAS

* WCCP

o B g I DE RS

* ABNE BRSS9

* DHCP % /i g5 #s AAREL. S0fF DHCP 14k,
* VPN g5 1)y

* MRS

o SRR R

* FIPS 1 5

EERFEE L INAE
DL R Sh A (il 2 AR, BRI R .

)

AR AP D RE AT DA B T U L ST TR B e b B

WERAG I AR DI RE, U2 50K S vh Th e XU BRI 0 B AP U e, SRS PRI R U
AT IIRE: WUORAEIENE L, %R SRR A& [ R R

X DIRETT 5, WA Y R AW, T T SRR T T, S AR T AP i
HEATIER.

© DU MR A
* DCERPC
* ESMTP
* IM

* NetBIOS
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* PPTP
* RADIUS
* RSH

* SNMP
* SQLNET
* SUNRPC
* TFTP

* XDMCP

o WA R AR

o PREET 1) IR S 90 UEFIFZ AL o KA 2315
* i S5

* i filH] VPN

* AHE

N2 BT SR Th BE
IXSE T HERE N B BEAS ASA 1 A AR EE AN B nl s iy a5

* Q0S-QoS MK T & Z L FE b fE4RBEP R D . (B2, ZRME EAEREATY A B AT . 11
fr, TR R R, DU R S ASA R R I A5 R0 £ 3 2 RN 4 ) (R 5
. EEE 3 AN A B eI oA AR, FF AN ) SR AR R T SRR 3
i,
o SR - M AE BT S RS AR B, HER S RO A AR e . Ay ]
FIASI A, R KA A T R T s, AN A E BT T,
PR s 1 A v 1A
o PP B - 2N SR I B R A AR A A A R DA RN T AT
* LISP Jii & - UDP ¥ I 4342 /Y LISP i & (i &AM st fTie 2, (HIEEH A S )
2o BEANTT SRS INBIAERE LK) EID %, {HJE LISP i A B i AS SERRIRS IR,

T ®4&i71e) 8 AAA FEcRf

T BT ) AAA T =800 41: S RAE. SRBNCIK. SRR IE AU R D e fE 4R A
P i s, ELACH Ak SR B AR T e A SR IEAS AR AL B AR R
KT E R, ARSI AT 2 1 S0 Uk i BEAT HI P S AR 2y nk Az ey,
3 B0 IE AR 25 PR R 00 B I R DR P
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PO AE A B S REAE SRR S o C KL AR R e i, RIIAE D I R e B G K, MR b i
B AR S A B AT IT Ua A 1B R A 3] AAA RS 2%

ERRETNEE
B SRR SRRV B RS (52 B & (Configuration)> B AIE (Firewall)> BR 5 55 #& (Service
Policy) TUIfiD o RN A ARYE T 3B B A TSRO R (T B . TR, e
i (1 3% 2 PRI T REAN 2 P e PR AR BB St e A0 s E AT AR 48 502 IR 0] 05 1 3 e 1 I A B
BRI T B de i . AN, ZE USRI, 25 20 B I 1) 17 B

MR FNERE
FERT B VRN, AN R A S BT () 5 HH B84 T B e RS0, FLAEAN T A 3R 6 e o
& 433 FE OB TR S H

Router A

All units are using OSPF
with neighboring routers

ECMP Load Balancing

w
2]
[22]
o
[+3]
(8}

Router B

EEEY, Blas A A 4 LSRRI th 8y B, FEAMAAE L] & ASA. ECMP [T
16X 4 W22 X PT84 5 ASA 105 /NI B 2@ S I, S HbE A [ (1) % 22
ID.

TS50 4% th 28 ID BC B — AR, AEREAN T S E G B ) il 2 1D
EIGRP 5 FANE RS AR BET S AR AR AR 8 e 2R o
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B remss
)
AR WRZERE NIRRT 2N SR AN 2 AR, X RR S iR RE 2 i AN v B A2 BT
Wk, TR R, 1EFB T XY ASA B OB E—REX I, 1HS R E X,
FTP Fn& 2%

© WIS FTP a8 TR 5 A JE A ph AN R O SR RS 3 AT DA B P AT 4 25 TR R I B
AL JVACE B S T T O SR A O N . (ERE U R EHT N 28 R B I S
FRE AR, WA TR/ TR R R R 2 R I A2

ICMPA&; T Fn &2 8%
ICMP F1 ICMP ‘85 50 A 0 ok 28 i i sk T2 35 8 H ICMP/ICMP #5342 . ASJA H ICMP #6 &
I, ICMP 2B MF, HHAZFERRER. BHICMPHER, ICMPRA X, I H s/
TSR WA I ICMP JR 1 — AN 2 ANAE T3 10 286 1 R B e AL EE . 5 ) 25 25K ICMP
[ 25 s L e R AR TR 3, A R B IR P e Rk 2%

‘HIBEE R FnEERE

FERRST A TSR, B AN AR A AR . A Al A et o 500 G # eh P i BE e HEAT AR BRI 2
NITpEER A EITRa N =R B

NAT FO&Ef
NAT 0] GE2 5E MR BE A B, AR HY 3l NAT Bl 40, n] 9 2 ik B EERE TR R[] K] ASA, BRIk 4t
B ET IR T TP M BRI 1, NAT 2 S U8 A 3l B 00 5 A AR [F) 1) 1P Huhk F/mkim 1. 24
B 20k 3 4E NAT Jifg & 1) ASAI, 2Bt SERE Rl a6 Rk BT &, SEUEEREHIEEY L
EERERE. WER, BT SN S ORI A & 1 ke, O NAT I & & T i 2
R 08 2 4 SR A, 7 45 SR A B L B i iz
R AT AR P ] NAT, 5% FE DL Ry
o AT AR ARP - 6} TR 1, U)2) Wbt (f st bk K6 ACHE ARP 0152 . X a) LAR 114042
PR CAANTEERE T ASA {R3FXT A5 R . 0 T3 M AERE IP Huhik fly s Mok, ik
FH 2% 7 B A I Hh | AT 6 2 EREE ) PBR. 3X K 5 R 4% EtherChannel SK i AN A& )@, R R —
AN TP Hbdik 5 ARz 11 Rk,

o ANKPPSTE U 92 11 PAT - B57.3% AR5 11 PAT.

* PAT X3 N HRIMHE - TS B iZ DD RERT LA T AEN -

o BEEHUR LR BRBIFAE AN ERAE, Mt S ] TR Rl A, AEREERLR K
BRI E A 1A 3 AN SRR, WURAEAHE 3 AN sl B ok B LA A & s
P, WIRTLLP I 3 AN B, BRI RLT A

o FESRATRE TN LB R B BRI, 752 it v A 48 01 st B 1 s VRN SR A
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o AR HEAT RN PAT HEMMETS O PAT St 4B i 1P M hEJE D, 2 S BRI A
I AT A i ) B A5 T8 473 348 SR A oA RS R0 AT A I A L B BE D BE TR AT
e MG E PAT i, R BT ARSI 1Y R 2 18] 7 POt R AT 77 8 1 (1 A
fHIE

© FESRRE RIS, ANREEE SRR/ R RSP BRI B, BiR
AINA AR i ET MBS, BT BN R AT B2 IO 37 B K e A
WAHSG RO AT e e SR, R mT AT SCBR R/ I 00T G el e o e R
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